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Introducing Report Manager

Overview

Use Win School Report Manager to build and print reports. You can run
reports throughout the school year, generate report cards, and update
historical marks at the end of the school year.

Creating custom reports is the primary function of Report Manager. School
staff can create and run custom-designed report templates that can be
shared between schools.

Templates define the form and content of reports. Report Manager
generates reports from Win School data according to the templates you
create.

Design and construct your own templates to report on Students, Teachers,
Rooms, Courses, Classes, and Resources available in Win School modules.

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939
fax: 1-800-346-0643
email: techsupp@chancery.com
website: http://support.chancery.com

Web support Chancery’s website includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for 3 months from your date of purchase
and are included in the subscription to Chancery
Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.
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Providing Feedback

To improve the quality of your documentation, we would like your
comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs@chancery.com.
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Using Report Manager

Overview

There are 2 windows for most tasks in Report Manager. The Main window
lists templates, students, teachers, rooms, courses, classes, and resources.
You create, delete, and print templates from this window.

You view, edit, and build templates in the Template window.

Using the Main Window

The Main window is always open when Report Manager is running. The
Win School Getting Started Guide describes the window conventions and
sorting procedures used in the Main window.

Click a view icon to display a corresponding list of items and columns of
related information for templates, students, teachers, rooms, courses,
classes, or resources.

You can only edit templates, not data, in Report Manager.

To use the Main window:

• To change the order in any list, choose Sort from the Edit menu.

• To control the contents of some columns, use VCR buttons.

• To display the name of the current view and the number of items it
contains, click the Report Manager information icon in the title bar.
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Using Template Windows

The Templates view provides access to the templates you have created or
opened.

If your school runs the multi-user version of Win School, all the templates
created and saved by all users on your network appear in the Templates
view.

Smart items generate the lists and sub-lists that make up the final report.

To use a Template window:

• Use the popup menu in the Template Type column to choose the
Win School module that has access to a template.

 Select All Modules to make the template available in every module.
You can change the Template Type at any time.

• Double-click a template name to display the template in a window.
Each template window displays a single template.

• The report that prints from a template is defined by the Report Manager
objects you place on that template, using the tools provided in the
Template window.

• You can open blank, untitled template windows and windows
containing templates you have previously saved. The number of
template windows you can have open simultaneously is limited only by
your computer’s available memory.

• To print the information shown in the Templates view, use the select
boxes in the right-hand column to identify the templates to include,
then choose Print from the System menu.
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 In other views, use the select boxes to select the students, teachers,
rooms, courses, classes, or resources to include in custom reports.

Using the Toolbar

Use tools from the Toolbar to draw and arrange the objects on your
template. All of the toolbar commands are available in the Edit, View,
Insert, and Set menus in the Template window.

If you are familiar with graphics software packages, you will recognize
many of the graphics features of Report Manager.

The best way to learn how to use these features is to experiment with them.
Try creating a new template by using each of the tools to place new objects
on the template and edit the existing ones. Delete the template by closing it
without saving it.

To use the Toolbar:

• Choose Toolbar from the View menu to hide or display the Toolbar in
the Template window. A check mark appears when the Toolbar is
displayed.

Quick reference for using the Toolbar

Click To do this

 Arrow Select, resize, and move objects.

 Hand Change the part of the template that is
visible in the Template window.

 Smart Item Put placeholders on templates that will
generate lists from your Win School
database.

 Text Enter text in the report.
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Click To do this

 Line Draw a line.

 Rectangle Draw a rectangle or square.

 Oval Draw an oval or circle.

 Object Association Control how text and graphics print in
relation to the lists generated by smart
items.

 Report Index Add a contents popup menu to the report
window so you can jump to the page that
contains the data you specify.

Shortcuts using the Arrow tool

For Double-click its border to:

Text Open the Font Attributes dialog.

Smart Item Open the Font Attributes dialog.

Line, Rectangle,
Oval

Open the Line, Rectangle, or Oval Attributes dialog.

Using the Ribbon

You can choose formatting options for text and smart item objects from the
ribbon. The ribbon appears immediately above the horizontal ruler at the
top left of the Template window.

To use the Ribbon:

• Choose Ribbon from the View menu to display or hide it.

Click To do this

Bold, italic, underline
Apply or removes text styles to selected text

Justification
Justify left, center, or right to align smart
items or text

 Larger font,
smaller font

Increase or decrease font size by 1 point
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Using the Ruler

The working area of the Template window is framed by a ruler on the left
side and across the top. When you start working on a template, scroll to the
right, bottom edge to see how much space you have to work with after you
have set the margins, page size, and orientation.

The ruler can display units in centimeters or inches. Click the upper left
corner (where the rulers intersect) to change measurement options.

Using the Status Bar

The Status Bar is a convenient way to identify smart items by title and
category.

When you select a Report Manager object, information about that object
appears in the status bar along the bottom of the template. The information
displayed depends on the type of object selected.

To use the Status Bar:

• Choose Status Bar from the View menu to display or hide it.
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Creating Templates

Overview

You use Report Manager to create report templates that you use to generate
reports in Report Manager or other Win School modules.

Creating a Template

There are 7 steps to creating a template:

1 Choosing page size and orientation, and setting margins.

2 Creating a new template.

3 Placing the smart items on the template.

4 Placing text and graphics on the template.

5 Setting filters and defining constraints.

6 Testing the new template by printing it to a Win School Report
Window.

7 Sending the report to the printer.

Choosing Page Size and Orientation

Before creating a report template, set up page orientation as portrait or
landscape, and define the paper size on which the report will be printed.
Using this information, Report Manager displays the report boundaries in
the Template window.

Define paper size and orientation before creating a template with the New
Template command because these settings cannot be changed.

Until you change these settings, every new template corresponds to the
maximum space available, according to the current page orientation and
size.

Printers cannot print to the edge of a page. Therefore, the width and height
of your template onscreen are slightly less than the size of the paper you
select. If you set custom margins, they will reduce the template area that
appears and prints.
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To select paper size and orientation for Report Manager:

1 In Report Manager, choose Page Setup from the System menu in the
Main window.

2 Choose Portrait or Landscape orientation. The page orientation icon
shows how text appears on the page.

3 Choose the paper size, than click OK.

To select paper size and orientation for all Win School modules:

1 In the Shell, choose Page Setup from the System menu.

2 Choose Portrait or Landscape orientation.

3 Choose the paper size, then click OK.

Setting Margins

Set margins to improve a report’s appearance or readability, for example,
margins you set to allow space for binding affect all Report Manager
templates. When you create a new template, its working area is the current
page size minus any margins you’ve set.

When you open an existing template, Report Manager adjusts its working
area to reflect the current margin settings. Objects that fall outside the
margin areas are not displayed onscreen or printed. They are not deleted;
they are outside the working area of the template.

To set margins:

1 Choose Margin Setup from the System menu in the Shell.

2 Choose units of measurement and type margin sizes, then click OK.

 To remove a margin, set it to 0.

 The margin settings are applied to all Win School templates and built-
in reports and remain in effect until you change them.
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Creating and Saving Templates

Close all open templates before working on a new template.

Save your template periodically as you work.

To open a new template window:

1 Start at the Report Manager Main window.

2 From the File menu, choose New Template.

To modify an existing template:

1 In the Templates view of the Main window, double-click a name.

2 From the File menu, choose Save As and save it with a different name.

3 Modify the renamed template.

To open a template saved to disk:

1 In the Main window, choose Load Template from Disk from the File
menu.

2 Select the drive, folder, and file to open.

3 Click OK.

Saving Templates
Templates are saved in your Win School database.

To save a template:

1 Choose Save from the File menu in the Template window.

2 Name the template when you save it.

To save to a diskette or a hard drive:

Use this function if you want to make the template available to users at
another location or as a backup copy.

1 Highlight the template name in the Main window.

2 From the File menu, choose Save Template to Disk.

3 Type a name for the template and select a location to save it.

 Template names are case sensitive.

4 Click OK.

Changing Access to Templates
If the template is to be run from a module other than Report Manager,
change the Template Type. The first time you save a template, the default
value for its Template Type is Report Manager.
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To change the template type:

1 In the Main window, highlight the template you want to print from
another module.

2 Click and hold on the Template Type column for that template.

3 Choose a module from the popup menu.

Placing Objects on a Report Template

If you are familiar with graphics software you will recognize many features
of Report Manager. If you don’t know how to use graphics tools, the
information in “Using the Toolbar” on page 5 will get you started.

You can cut, copy, and paste objects when you design templates in Report
Manager. You cannot paste an object from another application. When you
paste an object, it is pasted directly on top of the object you just cut or
copied. You can then move the pasted object.

Using Smart Items

Smart items identify data in your database and explain how and where to
print it.

The smart item boxes on a template are pointers to data in your Win School
database. When you print the template, the data prints in the report. Smart
items can be:

• Information or lists of students, teachers, rooms, courses, or classes

• One-occurrence information, such as a school principal’s name

• Descriptive information such as the current date or page number

• Smart pronouns; for example, he, she, him, her; used in comments
about students in the report

• Calculated values

• Current and historical smart items

• Attendance codes, values, and totals

Choosing a Smart Item Category

Smart items are organized in this order: categories, subcategories, and smart
item groups. In the example path shown below, Student is the category,
Attendance is the sub-category, Codes and Dates is the smart item group,
and Assigned Attendance Date is the smart item.
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Use 1 category per template. You cannot use smart items from more than 1
category on 1 template, except for items in the System category, which can
be used for dates, page numbers, and general information about your
school. The System information is usually used in template headers and
footers.

Since you cannot use smart items from more than 1 category, after you
place a smart item on your template, the unavailable categories are dimmed.
After adding a smart item from the Classes category, for example, you
cannot use the Students category, but you can select student smart items
from a level of the Classes category.

If you have placed smart items from the wrong category on your template,
delete all of them and start over.

To choose a category:

1 Decide what you want to report, filling in the blanks in these sentences:

 For each [    ] print a list of [      ].

 For each [    ] include [   ], [   ], etc.

 For [    ] include [   ] etc.

2 From these decisions, choose the category and the levels for the
template. For example:

 For each student print a list of classes.

 For each class include marks, and attendance.

 For marks and attendance include comments.

 In this example, you would choose the Students category.
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Choosing Smart Items

Click the  tool to select a smart item and to change the contents of a
selected smart item on a template.

Click  to open the Smart Items window. After creating a smart item,
double-click  when the template is open to bring the Smart Item
window into view again.

To choose a smart item:

1 Click the  tool, then click in an empty part of the template to make
sure no other object is selected.

2 Click  to activate the Smart Item tool and open the Smart Items
window.

3 Double-click the appropriate category and folder to access the smart
items you want.

4 Click a smart item to highlight it. To choose an alternate title, use the
VCR buttons.

5 Click the Template window to activate it. The mouse pointer appears as
a set of crosshairs.

6 Click and drag to draw a box containing the smart item you selected.
You can do this in the area outside of what is visible onscreen by
dragging the crosshairs through the border of the Template window.

 Release the mouse button and the title of the selected smart item
appears in a box, in the currently selected font, size, and style.

 The size of the smart item box determines the space available to print
the data. If too little space is provided, Report Manager prints as much
data as will fit in the smart item box, followed by an ellipsis (…). You
might have to experiment by printing the report to ensure you have
enough space for your data.

Creating a Smart Item with a Label

You can label smart items to make data easier to understand when you print
templates. Labels such as Name or Grade before a list of student names or
grade numbers, for example, gives meaning to what would otherwise be
just lists of data.

To create a smart item label:

1 Click the Text tool to create a text box, then type text in it.

2 To re-size the text box, click the Arrow tool, select the text box, then
re-size it.

3 Click in the text box where the smart item is to be placed.
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4 In the Smart Item window, double-click the smart item to place it in the
text box.

 At some point, you will have to associate the text box with the smart
item. If you don’t associate these items, the text box will print in the
same place at the top of every page, regardless of where a new listing
starts. See “Linking and Layering Objects” on page 19.

Changing a smart item

• Select the smart item box on the template, then double-click another
item in the Smart Items window.

• Reformat the smart item in the template view by using the Ribbon or
commands from the Set menu.

Using Smart Pronouns

Use smart pronouns in text or comments that refer to gender. For example,
in “Tony needs to return his permission slip,” the pronoun “his” is a smart
pronoun. A popup menu in the Smart Item Definition dialog provides a
selection of pronoun pairs. In the printed report, pronoun gender will match
the student name.

To use smart pronouns:

1 Place a Gender smart item on the template.

2 Click the Template window, then click the Arrow tool.

3 Double-click inside the Gender smart item box to display the Smart
Item Definition dialog.

4 From the Pronoun popup menu, choose a format.

5 Select Case to specify capitalization, then click OK.

Using Calculated Smart Items

Calculated smart items generate totals, subtotals, averages, and percentages
based on student attendance and marks. Select calculated smart items in the
following categories:

• Attendance-Calculated

• Marks-Calculated

• Year’s Totals
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Using Attendance-Calculated Smart Items

You can use 2 types of Attendance-Calculated smart items: Sub-totaled,
which prints attendance data for each individual student; and Calculated,
which prints an attendance total for every student.

Using Marks-Calculated Smart Items

Use Marks-Calculated smart items to print marks data for each individual
student for the current year. Marks-Calculated smart items that use bin
attendance also have some of the options of Attendance-Calculated smart
items.

If you want to report on the current year and previous years, you must use
Cumulative smart items. See “Using Cumulative Smart Items” on page 17.

Using Year’s Totals Smart Items

In the Students/Historical Year/Historical Classes/Year’s Totals smart item
group, you can use the historical version of almost all the calculated smart
items. These smart items print a single, totaled value for each year you
defined in your Historical file. If you’ve updated your Historical file, this
can include the current school year. Double-click a smart item to define it.
Generally, you define smart items that report bin information, attendance,
and student names.

If you use one of these smart items, you must also use at least one smart
item from the Student/Students/Historical Year/Historical Classes/Class
Information smart item group, which is located in the same sub-category.

Calculated Smart Item Descriptions

Calculated Smart Item Name Description

Sub-Totaled Calc. Daily
Attendance

Sub-Totaled Calc. Period
Attendance

Sub-totals of values or occurrences for present, absent,
or late daily or period attendance codes, excused or
unexcused

Calc. Bin Attendance Absent Sum of absent values or occurrences

Calc. Bin Attendance Late Sum of late values or occurrences

Calc. Bin Attendance Present Sum of present values or occurrences

Calc. Daily Attendance Sum of values or occurrences for present, absent
(excused or unexcused) or late (excused or unexcused)
daily attendance codes

Calc. Earned Credits Sum of the earned credits recorded in Report Cards
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Calculated Smart Item Name Description

Calc. GPA GPA

Calc. GPA Average Percent Average percentage mark using the current GPA
calculation method

Calc. GPA Earned Credits Sum of earned credits recorded in Report Cards, using
calculation method you specify

Calc. GPA Earned Potential
Credits

Sum of potential credits recorded in Report Cards for
marks flagged as both used in credit and used in GPA

Calc. GPA Marks Count of marks used in calculating GPA

Calc. GPA Marks Earned
Credits

Count of marks used to calculate the Calculated GPA
Earned Credits smart item

Calc. GPA Marks Percent Count of marks used to calculate the Calculated GPA
Average Percent smart item

Calc. GPA Numerator Numerator for GPA calculation

Calc. GPA Potential Credits Sum of potential credits recorded in Report Cards for
marks used in calculating GPA

Calc. GPA Weighted Weighted GPA

Calc. GPA Weighted
Numerator

Numerator for weighted GPA calculation

Calc. GPA Weighted
Potential Credits

Sum of potential credits recorded in Report Cards for
marks used in calculating weighted GPA

Calc. Grade Points Average of grade points recorded in Report Cards

Calc. Pass/Fail Count of marks flagged pass or fail in Report Cards

Calc. Percent Average percentage mark

Calc. Period Attendance Sum of values or occurrences for present, absent, late
period attendance codes, or excused or unexcused

Calc. Potential Credits Sum of potential credits recorded in Report Cards

Calc. Used Earned Credits Count of marks flagged as used in credit in Report
Cards

Calc. Used GPA Count of marks flagged as used in GPA in Report
Cards

Course Average Average of course marks recorded in Report Cards

Section Average Average of section marks recorded in Report Cards
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Using Historical Smart Items

If your school maintains a Historical file, you can use historical smart items
for class, mark, and attendance information from previous years for
students enrolled in your school.

Where items from the Student/Historical Years/Historical Classes/Year’s
Totals smart item group prints an individual value for each year in your
Historical file, items from the Student/Historical Years/Cumulative Totals
smart item group prints a total for all years in your Historical file. The
Historical file can include the current year if you update this file during the
current school year.

Historical Classes
Student/Historical Years/Historical Classes contains Year’s Totals and
Class Information groups.

As described in “Using Year’s Totals Smart Items” on page 15, the Year’s
Totals smart item generates a single, totaled value for each year you define,
based on historical bin information. You must place at least one smart item
from the Student/Historical Years/Historical Classes/Class Information
smart item group on the template.

Items from the Class Information smart item group, for example, print an
item for each class included in the report.

By default, each calculated total for a year is based on all classes for one
student for a particular year and is stored in the Historical file.

See the next section for information about using historical smart items from
the Student/Historical Years/Cumulative Totals smart item group.

Using Cumulative Smart Items

Cumulative totals are the totals of historical and current data. Cumulative
smart items are in Student/Historical Years/Cumulative Totals and
Student/Classes/Marks - Calculated.

You must place at least one smart item from Student/Historical Years/Year
Information on a template that contains a cumulative total.

Cumulative smart items generate a single calculated average, percentage, or
sum for each student listed in a report, based on mark or attendance
information from selected Historical and current year bins.

Cumulative totals work with smart items from Student/Historical
Years/Year Information. Year Information smart items print an item for
each year included in the report. By default, cumulative calculations are
based on all years stored in your Historical file.

• To restrict the range of years for cumulative calculations, choose
Historical Years from the Constraints dialog. In Report Cards, you can
use the Set Student Grades for Calculations menu located in the
Historical menu to set the years used in cumulative calculations.
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• To include data from the current year, select “Include current year in
cumulative totals” from the Marks tab in the Report Option Filters
dialog. See “Using Filters and Constraints” on page 22 for more
information about the Report Option Filters dialog.

The Cumulative Grade Points in Student/Classes/Marks - calculated is the
total number of grade points earned, including history and current year.

Defining Smart Items

You can modify the format of some smart items to ensure that your report
template prints the data you expect in the format you want.

Define smart items to specify details such as name orders, date formats,
student contact to report, and which bin to take marks from.

To define a smart item:

1  In the Template window, click a smart item, then choose Smart Item
Definition from the Set menu.

 OR

 Click the  tool, then double-click inside a smart item.

2  Make selections from the popup menus, then click OK.

 Not all smart items can be defined. It is suggested that you try to open
the Smart Item Definition dialog of every smart item you place on a
template.

Checking Smart Items

Check that the expected data in the expected format will print and that you
have provided enough space to print the data.

1 Select a smart item in the template.

2 Choose Smart Item Definition from the Set menu.

3 From the Set menu, choose Object Attributes.

4 From the View menu, choose Status Bar to display the status bar. Click
the Arrow tool, then click the smart item and look at the status bar to
check the status of the smart item.

5 Repeat for each smart item on your template.
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Using Text and Graphics

Most templates designed in Report Manager contain smart items that print
levels of information. Label your data and improve the appearance of
reports by adding text and graphics.

To make text or a graphic print with each smart item, do one of the
following:

• To link text or graphic objects with smart items, select them and choose
Object Association from the Set menu.

• Create the smart item inside a text box.

To create a smart item inside a text box:

1 Create the text object and type the text.

2 Size the text box if necessary.

3 Click inside the text box where the smart item is to be placed.

4 Double-click the smart item in the Smart Items window to place it at
the point you selected in the text box.

Linking and Layering Objects

A text or graphic object on a template, when not linked to a smart item, will
print in a fixed position on every page. The smart item can print in less than
a page if it generates a few words, or on several pages if it generates a list.

Any text or graphic object that is linked with a smart item will print once
for each item in the list generated, no matter how long the item.

Smart items cannot be linked to each other.

A linked smart item has a green selection box, and a linked object has a
blue selection box.

To link a text or graphic item with a smart item:

1 Click the Object Association  tool.

2 Click the smart item.

3 Press Shift, then click the graphic or text item.

 To link more than 1 object with a smart item, hold down Shift as you
click each object.

To unlink:

• Repeat the linking procedure, but press Shift as you click each linked
object you want to remove from the link.
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To check if an object is associated with a smart item:

1 Click the Object Association tool.

2 Click the object.

 If the object is associated with a smart item, the smart item displays a
green selection box. Associated objects display blue selection boxes.

 If the object does not select, your system beeps, and no blue box
appears, the object is not associated with a smart item.

To create a graphic background for a report:
1 Choose the object that is to be background.

2 From the Arrange menu, choose Send to Back.

3 Select the object that is to appear over the background.

4 From the Set menu, choose Bring to Front.

5 To provide layers, choose the Move Back and Move Forward
commands from the Set menu to move objects one layer at a time.

Setting Page Breaks

A report prints continuous information if you don’t set page breaks.

To set page breaks:

1 From the Set menu, choose Page Breaks.

 The dialog lists the names of all levels used by the current template.

 The levels are listed in the order you selected them in the Smart Items
window, not the order in which they appear on the template.

2 Click a checkbox to select a page break location

3 Click OK.

Controlling Spacing in Lists

You can control 4 kinds of spacing in a template.

To control relative positions of objects in 1 category:

• Position them on the template.

To control relative positions of objects for consecutive items in a list:

• Increase or decrease the size of the smart item box.

• Set page breaks.

To control relative positions of objects from 1 level to a sub-level:

• Position them on the template.
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To control relative positions of sub-levels and levels to show their
relationship to each other:

• From the Set menu, choose List Spacing and set the list spacing to
greater than zero. Click OK.

 You can also insert a blank space between lists by choosing List
Spacing from the Set menu, and setting the list spacing to greater than
zero.

Creating Columns

You can print lists either horizontally or vertically in columns.

Horizontal lists across Vertical lists from top to bottom

A B C A E I

D E F B F J

G H I C G K

J K L D H L

To create more than 1 column:

1 From the Set menu, choose Number of Columns.

2 Enter a number.

3 To print horizontal columns, select Horizontal Columns.

4 Click OK.

Creating Headers and Footers

Headers and footers appear at the top and bottom of every page of a report.

You can place only smart items from the System category in headers and
footers. The System category contains smart items for the current date, the
page number, and general information about your school.

To create headers and footers:

1 Click  and position the cursor directly under the horizontal ruler.

 The arrow turns into an open hand when it is over the fixed header bar.

2 Click and hold to close the hand and grab the fixed header bar, then
drag down to create space for a fixed header.
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3 Do the same at the bottom of the template to create a footer.

4 Place text, graphic objects, and smart items from the System category
in the header and footer.

To remove a header or footer:

• Drag the fixed header or footer bar out of the template working area.

 Any objects that were in the header or footer area remain in place at the
top or bottom of the template, and will display and print normally. To
delete these objects from the report, select and delete them.

Using Filters and Constraints

You use filters and constraints to control the Win School data printed by a
template. Filters are pre-defined, while constrains require your input. To be
included in a report, data must satisfy both the filters and the constraints
you have set.

Normally, you only need to check the filters on tabs that have settings for
the type of items included in your report. Filters on other tabs will not affect
the output. The exception is the Teachers dialog, because Report Manager
relates classes to teachers.

When printing reports containing class information, check the Teachers
dialog. Smart items from Students/Classes, for example, will only print
classes taught by female teachers if the Gender filter on the Teachers tab is
set to Female.

To view the Report Option Filters dialog:

• In the Main window, choose Print Using Highlighted Template from
the Reports menu.
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If you can’t find the items you need in the filters, click Constraints at the
bottom of the Report Option Filters dialog to open the Constraints dialog.
You can create constraints based on almost any smart item in your
Win School database.

Also use the Constraints dialog to define a range for the number of levels
that must exist for a higher-level item to be included in the report. In a list
of students by class, for example, you can specify that you want to print
only those classes that have between 20 and 30 students.

Filter settings are saved between sessions, and are applied to all templates
when you print them. Constraints are saved with individual templates.

To reset all filters to the default settings:

1 Quit Report Manager.

2 From the File menu in the Win School Shell, choose Clear Module
Preferences, then click Yes.

Setting Filters

1 Choose an option from the top popup menu.

Choose To print

All All items in the Main window

Highlighted All highlighted items in the Main window

Selected All selected items in the Main window

Honor Roll All students in the Main window who are
selected and on the Honor Roll

Honor
(Weighted)

All students in the Main window who are
selected and on the weighted Honor Roll

Not Honor Roll All students in the Main window who are
selected and not on the Honor Roll

2 Click the VCR buttons to display filters.
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3 Click a tab to select a dialog, then select a filter.

Filter To

Off Not included in report

Yes Include only items with a value of Yes

No Include only items with a value of No

Male Include only males

Female Include only females

All Include only items with a value of All

N/A Include only items with a value of N/A

Selected Include only items selected in next step

other options Include the selected item

4 Use the VCR buttons to choose other options, then click the
checkboxes to select data to include in the report.

5 Click Print to display the report, then choose Print from the System
menu to send the report to a printer.

Choosing Bins
Choose the Marks tab in the Filters dialog to select report card bins for use
by calculated marks and historical smart items, and to specify whether to
include the current year data in cumulative calculations.

To select bins for Calculated and Historical smart items:

1 Click the Marks tab in the Report Option Filters dialog.

2 To select specific bins for use in a historical calculation, click the VCR
buttons at the top of the Bins list to display Historic Bins.

3 Select each bin to be included in the report.

To include data from the current year in cumulative calculations:

1 Click the Marks tab.

2 Select Include current year in cumulative total.

Setting Attendance Dates and Periods
Choose the Attendance tab to specify a date range for attendance smart
items and to select the periods used for some period-attendance smart items.
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To set date ranges and select periods:

1 Click the Attendance tab in the Report Option Filters dialog.

2 Select each period to be included.

Using Constraints

You can create 2 types of constraints:

• If your report contains 1 or more sub-categories, use the General
constraints tab to define a range for the number of sub-categories that
must exist for a category to be printed in the report.

• Use the other tabs, the smart-item constraints, to define specific
requirements for selected smart item data. The tab to the right of the
General tab is the dialog for the first sub-category within the category
that will be included in the report. The tabs further to the right are for
constraining the smart items within each of the defined sub-categories.

Defining General Constraints

Use General constraints to define the number of occurrences to be included
in the report.

The Level Name column displays the names of sub-categories used for the
template. You cannot edit this list. If the report does not contain more than
1 level, the Level Name column is blank, and General constraints cannot be
entered.

To define a constraining value:

• Enter values in the Minimum Count and/or Maximum Count column
for the level you want to work with. These constraints restrict the
output of the category.

 If you leave both values blank for a level, it will not be constrained by
the number of occurrences. However, you can enter other constraints in
the other dialogs.

Defining Smart Item Constraints

There is a tab for each sub-category you can constrain within the category
of the template. Constraints on sub-categories are based on smart items, but
the smart items you select do not have to appear on the template.

You can restrict a student list to printing students with a specific medical
alert, for example, even though the template contains only name and
address smart items, or you can constrain unlisted phone numbers to be
printed as “unlisted.”
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To set constraints:

1 Choose the tab for the level you want to work with.

2 In the Category list, click a title to display the list of smart items. Use
the VCR buttons in Title to display alternate titles .

3 To add a smart item, highlight it in Title, then click Add.

4 Double-click a smart item in the upper list to display its Smart Item
Definition dialog.

5 Make selections to define the constraints.

 If you are working with a date smart item, you can specify a date
format that will constrain only 1 element of a date, and ignore the
others. If you set the constraint date format to Month for birthdate, for
example, the constraint prints everyone born in the specified month,
and ignores the date and year.

6 Click Remove to delete the smart item. Click Clear All to delete all
smart items and start over.

Choosing Relation Options
The Relation column contains a popup menu of relation options available
for the constraint smart item.
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Choose this To constrain a smart item in this way

Contains The smart item data must include the Value

Ends at The smart item data can be the same as the Value or
come before it alphabetically or chronologically

Ends with Text only - the characters at the end of the smart item
data must exactly match the Value

Equal to The smart item data must exactly match the Value

Greater or equal The smart item data can be the same as or greater than
the Value

Greater than The smart item data must be greater than the Value

Less or equal The smart item data can be the same as or less than the
Value

Less than The smart item data must be less than the Value

Not contains The smart item data must not include the Value

Not equal to The smart item data can be anything but an exact match
with the Value

Starts at The smart item data can be the same as the Value or
come after it alphabetically or chronologically

Starts with Text only - the characters at the beginning of the smart
item data must exactly match the Value

Not applicable Constraints based on Student Conduct, Status, and User
Defined Codes only: if only 1 smart item in the group is
applicable to the constraint, the other smart items are set
up as not applicable

Entering Values

To enter a value for most smart items, put the cursor in a Value cell and
type a value.

You can leave Value empty for a text field, after the equal to or not equal to
relation. The template then looks for items that either have no data entered
in the smart item field, or that have any data entered in that field.

Yes/No flags, checkboxes, popup menu fields and dates always have a
value, if only N/A.

The Value for a numeric field defaults to zero if you leave it empty.
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Using Operator

Constraints are separated by either “and” or “or.” Use the popup menu to
toggle between these operators.

Use when you want each item to meet more than 1 constraint.

The order in which you list constraints is important when you have a
mixture of “and” or “or.” To select a list of Grade 5 students in Homeroom
100, for example, the grade must be 5 and the homeroom must be 100, as
shown in the table below.

Student Grade is 5 Hmrm is 100 Grade is 5 and Hmrm is 100

Grade 5, Hmrm 100 Yes Yes Yes

Grade 5, Hmrm 101 Yes No No

Grade 6, Hmrm 100 No Yes No

Grade 6, Hmrm 101 No No No

The same criteria, separated by or, generates a much longer list.

Student Grade is 5 Hmrm is 100 Grade is 5 or Hmrm is 100

Grade 5, Hmrm 100 Yes Yes Yes

Grade 5, Hmrm 101 Yes No Yes

Grade 6, Hmrm 100 No Yes Yes

Grade 6, Hmrm 101 No No No

For a list of Grade 5 and 6 students, a student would not be in 2 grades at
the same time.

Student Grade is 5 Grade is 6 Grade is 5 or Grade is 6

Grade 5 Yes No Yes

Grade 6 No Yes Yes

Grade 7 No No No

Constraining Student Code Smart Items

Student codes exist as groups of fields in Win School. When you add their
smart items to the Constraints, a group of smart items is added.

Three types of data can constrain reports: Status Codes, Conduct Codes,
and User Defined Codes. Status Codes contain data about student
enrollment status, such as entry, withdrawal, and re-entry. Conduct Codes
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contain data about student infractions that require disciplinary action, or
exemplary behavior that is rewarded. User Defined Codes track status such
as citizenship or at-risk status, where a student has only 1 status at a time.

To build constraints based on student code data:

1 Place the Student Name smart item on a template.

2 Depending on which type of student code you are reporting on, place a
smart item on the template from the appropriate Category/Sub-
Category: Status Codes/Status Code Info; Conduct
Information/Conduct Code Info; Student User Defined Codes n/User
Defined Codes n.

3 Choose Constraints from the Edit menu, then click the tab for that
student code.

4 In the Category section, click applicable folder.

5 In the Title section, double-click the smart item (Multiple Items) you
are reporting on.

 The required smart items appear in the top section of the dialog.

6 Edit the Relation and Value columns as required.

 Set the Relation column popup menu to not applicable for all smart
items that do not apply to the constraint.

 Leave all Operator column items at “and.”

7 Click OK to return to the template.

8 Save or close the template to save the constraints.
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Printing Reports

After you have placed objects on a template, you can generate a report to a
Win School report window.

Always save templates before printing. Report Manager uses the most
recently saved version of a template to generate reports.

1 In the Templates view in the Main window of Report Manager,
highlight the name of the template.

2 From the Reports menu, choose Print Using Highlighted Template.

3 If your template contains smart items, use filters to specify what to
include in the report.

 If you can’t find the items you need in filters, click Constraints to
create constraints.

4 Click Print to send the report to a Win School report window, then
choose Print from the System menu to send the report to a printer.

 OR

 Click Cancel to return to the Main window.

Creating a Report Index

To navigate through long reports and find items easily in the report
window, you can create a popup menu in the generated report.

1 Open the report template.

2 Click the  Report Index tool in the toolbar.

3 Click the smart item that will generate the index, for example, Student
Name.

4 Close the template.

5 Click Yes to save the changes.

When a report is generated from the template, the output from the report
index smart item appears in the Contents popup menu, at the top right of the
report window. Choose an item from the popup menu to jump to the page
containing that item.
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Tips for Creating Templates

Including Totals and Grand Totals

Total and Grand Total smart items generate counts of students, teachers,
and classes on templates.

The Total is positioned relative to the last item in the list on which it is
based.

The Grand Total is printed relative to the first item that appears in the list
on which it is based.

To add a total to a report:

• Select the Total smart item from a Student, Teacher, or Classes
category or level in the Smart Items window.

When you use a Total smart item, always place at least 1 other smart item
on the template from the same category or sub-category as the Total.

To add a total to a report with sub-categories:

• In reports that contain levels, use a total smart item to print the number
of items in each level.

• Use a Grand Total smart item to print the number of items in the entire
report.

Grand Totals are based on Totals, so place the corresponding Total smart
item on a template that contains a Grand Total even when you would not
otherwise need to add a Total to the report.

Printing Totals

Extra vertical space can occur between the end of a list and its Total or
Grand Total in multi-page reports. To avoid this, use Total and Grand Total
smart items in draft reports to check calculations, and avoid placing them in
reports you need formatted for presentation.

To add a text label to describe a Total or Grand Total, associate the text
object with the appropriate Total or Grand Total smart item. See “Linking
and Layering Objects” on page 19.

Printing Student Addresses

The Student Address smart item automatically pulls together information
from various fields.

Report student address information with smart items from the
Student/Address Info level. Smart items that begin with the word Residence
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use information from the Physical Address fields on a student’s Personal
dialog in the Details module.

Smart items that begin with the word “Mailing” use information from the
Mailing Address fields on a student Personal dialog in Details. A student’s
physical address and mailing address are usually the same and are entered
in the Physical Address fields only.

To add a full address using the Student Address smart item:

1 Open the Student/Address Info level in the smart item window.

2 Select the Student Address smart item on the template.

3 Make a smart item box large enough for a complete address in the font
size printed in the report.

4 Select the  then double-click within the smart item box to open the
Smart Item Definition dialog.

5 Use the Address Format popup menu to specify how you want the
address printed. The option you select depends on the Student Address
Format setting your school uses.

6 For the 2 Address Lines format:

Choose To Print

If no Mailing,
Physical 2 Lines

The Physical Address prints if both the Mail
Addr 1 and Mail Addr 2 fields are empty.
Otherwise, the Mailing Address is used.

If no Physical,
Mailing 2 lines

The Mailing Address prints if both the Phys
Addr 1 and Phys Addr 2 fields are empty.
Otherwise, the Physical Address is used.

Physical 2 Lines Physical Address

Mailing 2 Lines Mailing Address

 For the 5 Address Fields format:

Choose To Print

If no Mailing,
Physical 5 Fields

The Physical Address prints if all 3 of the Mail Addr
Num, Mail Addr Street, and Mail Addr Apt. fields are
empty. Otherwise, the Mailing Address is used

If no Physical,
Mailing 5 Fields

The Mailing Address prints if all 3 of the Phys Addr
Num, Phys Addr Street, and Phys Addr Apt. fields
are empty. Otherwise, the Physical Address is used

Physical 5 Fields Physical Address

Mailing 5 Fields Mailing Address
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Troubleshooting

Class list prints only 1 student and class on the report

Report options might be set to print for Highlighted students, teachers, or
classes. Set the popup menu in the Report Options dialog to Selected or All.

See “Selecting Report Options” in the Win School Getting Started Guide
for information on the Report Options dialog.

Inactive students show in Report Manager reports

Report Manager reports list all students that you display. If you don’t want
to print inactive students, do not display them.

To hide inactive students:

1 Start Report Manager, then choose Preferences from the Edit menu.

2 From the Edit menu, choose Win School : System.

3 Click the Miscellaneous tab.

4 Select one of the Hide options, then choose Save from the File menu.

5 Close the dialog.

Cumulative Marks don’t print

To ensure that cumulative smart items from the Student/Classes/Marks-
Calculated level use the correct bins, use the following procedure if:

• you use any current-year bins from 13 to 30 for marks used in
cumulative calculations such as Cumulative GPA

 OR



Win School Report Manager

34    Troubleshooting  •  Your report doesn’t print correctly

• the current-year bins used in cumulative calculations are different from
the Historical bins used

To print cumulative marks:

1 In the Report Cards module, update the Historical file for all students.
Update this each time you print report cards.

2 When you print a template using a cumulative smart item, the Report
Option Filters dialog appears. Click the Marks tab.

3 Deselect “Include current year in cumulative totals.”

4 Click the VCR button to display Historic Bins.

5 Select the bins to include.

6 Click Print to display the report on your screen, then choose Print from
the System menu to send the report to a printer.

Your report doesn’t print correctly

The report stops generating, or the progress meter stops short of 100%

Your system might have run out of disk space. When you generate
Win School reports, they create temporary files that are stored on disk. The
exact location is determined by the Temp= setting in your WinSchl.ini file.
Check the amount of free disk space, and delete any unnecessary files.
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A paper copy of a report won’t print from a Win School report window

If your report appears in the report window, the problem is with your
printer or your connection to it.

• Check that your printer is installed and set up correctly, using the
Printers option in the Windows Control Panel.

• Check that your printer is turned on and is connected to your computer
or network.

A report with class information does not print for all classes

Check the Teachers tab dialog in the Report Options Filters dialog. Report
Manager only reports on classes taught by the specified teachers.

Report objects are inconsistently spaced, especially in headers and footers

You might have a problem with your Windows printer driver. Get an
updated printer driver from the manufacturer.

Titles are obscured by other text after first page

Text and graphics that aren't smart items print in the same position on every
page, unless the text or graphic object is associated with a smart item.
Sometimes text generated by smart items prints on top of other text or
graphics, on pages after the first page.

To fix this, use the Object Association tool to associate the text and graphic
objects in your title with the first smart item on your template.

See “Linking and Layering Objects” on page 19.

You can’t get into a smart item category

Report Manager can print smart items from the System category as well as
1 other top-level category per template. After you place a smart item on
your template, all other smart items you select must be from the same
category or 1 of its sub-categories. The unavailable categories are dimmed.

If, for example, you add a smart item from the Classes category, you cannot
get into the Students category because they are both at the highest category
level.

If you have placed smart items from the wrong category on your template,
delete them all to make other categories available.
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You can’t see “All” in the Report Option Filters popup list

The popup list box can only display 4 items at a time.

Use the up arrow key on the keyboard to move the highlight bar to the top
of the list where you’ll see All.

You can’t select popup list items with a mouse

If you are running MS Office 4.2 or HP Jet Direct in the background, you
may encounter this problem.

Exit MS Office or HP Jet Direct, or use the keyboard to make your
selection.

You receive the error message:

“No Records Selected”

If you receive this message, a constraint or filter is not set or is not set
correctly.

To reset a constraint or filter:

1 Choose Print Using Highlighted Template from the Reports menu.

2 Click Constraints.

3 Click one of the Constraint smart item tabs, then click Clear All.

4 Change the selection on all filters to either All or Off, then click Print.

 Reset constraints or filters until you find out which constraint or filter
is causing the problem.

“The report cannot be run since no records were selected”

Check the Report Option Filters dialog. If you specified Selected or
Highlighted in the list box on 1 of the tabs, make sure you have items
selected or highlighted in the appropriate Main window views.

Your computer freezes while generating a report

Wait a few more minutes for the report to print. Depending on the size of
the database and number of students, large reports can take a long time to
process.
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